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	Date:
	4/17/2002

	Name of Product:
	Microsoft® Visio® Standard 2002
Microsoft Visio Professional 2002

	Contact for more Information:
	http://www.microsoft.com/office/visio
http://www.microsoft.com/enable 


Differences between Microsoft Visio Standard 2002 and Microsoft Visio Professional 2002

References to the following diagram types apply only to Microsoft Visio Professional 2002:

· Web diagramming

· Building plans

· Space planning

· Process engineering

Legend

( Microsoft usability research indicates that the exceptions noted are not significantly disruptive to product functionality. In some instances, this symbol indicates that the functionality described is accessible through equivalent, alternative means, via the keyboard utilizing standard menu options.

Summary Table

Voluntary Product Accessibility Template

	Criteria
	Supporting Features
	Remarks and explanations

	Section 1194.21 Software Applications and Operating Systems
	
	See section 1194.21 below.

	Section 1194.22 Web-based internet information and applications
	
	Microsoft Visio 2002 is not considered a web-based internet information and applications product, although it does support saving in HTML format. See section 1194.22 below.

	Section 1194.23 Telecommunications Products
	
	Microsoft Visio 2002 is not considered a telecommunications product.

	Section 1194.24 Video and Multi-media Products
	
	Microsoft Visio 2002 does not use multimedia except as covered in section 1194.21.

	Section 1194.25 Self-Contained, Closed Products
	
	Microsoft Visio 2002 is not a self-contained product.

	Section 1194.26 Desktop and Portable Computers
	
	Microsoft Visio 2002 is software as defined under section 1194.21.

	Section 1194.31 Functional Performance Criteria
	Supported with minor exceptions. Please refer to the attached VPAT.
	See section 1194.31 below.

	Section 1194.41 (a) Information, Documentation and Support
	Supported with minor exceptions. Please refer to the attached VPAT.
	See section 1194.41 below.


Section 1194.21 Software Applications and Operating Systems - Detail 
Voluntary Product Accessibility Template
	Criteria
	Supporting Features
	Remarks and explanations

	(a) When software is designed to run on a system that has a keyboard, product functions shall be executable from a keyboard where the function itself or the result of performing a function can be discerned textually.
	Supported with minor exceptions:

Microsoft Visio 2002 supports Microsoft Windows® accessibility features including StickyKeys, FilterKeys, MouseKeys, High Contrast, and more. 

Keyboard access is provided throughout Microsoft Visio 2002. Keyboard shortcuts, shortcut keys, and menu commands are readily available in Visio 2002. 

Visio 2002 Help functionality includes easily accessible reference guides for keyboard accessibility. 


	General features

· The endpoints of connectors cannot be moved via the keyboard so as to complete “glue” operations with other shapes. However, two shapes can be automatically connected through keyboard-accessible commands.

· Arc and freeform line elements (including control handles, vertices, and control points) cannot be positioned via the keyboard; however, some can be manipulated through the Visio ShapeSheet® interface, which is fully keyboard accessible.  

· ( The icon editor window, which allows Visio solution developers to edit the shape icon shown on the stencil (not the shape itself), cannot be accessed via the keyboard. However, bitmap data from other sources can be pasted into the window.

· Anchored windows, including the Pan & Zoom window, Custom Properties window, Size & Position window, and Drawing Explorer, cannot be moved, sized, floated, docked, anchored, or merged via the keyboard. However, since the windows themselves and their controls can be manipulated via the keyboard when in focus, the information contained in these windows is fully accessible.

· ( The date chooser control in the Custom Properties window cannot be accessed via the keyboard. However, dates can be entered into the date field as strings via the keyboard.

· Although some keyboard accelerators are visible on menu bars, others are never shown. 

· ( Currently, the user can navigate selection of objects on a drawing page via the Tab key but not the directional keys.

· Visio menus cycle back to the top of the menu once a user has moved beyond the last item. Guidelines recommend that a beep should occur when the last item is reached and that the selection is not returned to the first item in the menu. 

· ( Some Visio dialogs containing radio button groups with dependent controls do not follow a recommended tabbing order for use with screen readers. The dialogs are:

File > Page Setup > Print Setup

File > Page Setup > Page Size

File > Page Setup > Drawing Scale

Edit > Insert Object

Features specific to diagram types

Organization Chart has thorough keyboard support throughout the dialogs and the wizard. Minor issues are outlined here: 

· ( In the Organization Chart Converter (used to incorporate current organization chart functionality into organization charts created in Visio versions prior to 5.0c), arrow keys do not toggle between radio buttons. However, the affected radio buttons are accessible via accelerator keys. 

· ( The “Move shape left” and “Move shape right” icons are enabled on the solution toolbar even when disabled in the solution menu. This does not affect the use of the product, but it is inconsistent with expected behavior. 

· ( The Organization Chart > Arrange Subordinates dialog exhibits unexpected order behavior when arrows are used to navigate between selections. 

Project Schedule functions support keyboard accessibility except in the following cases: 

· ( The Timeline shape right mouse action (RMA) accelerator key for accessing the Configure Timeline dialog conflicts with the Cut menu (both use the letter “t”). However, Configure Timeline can be accessed by choosing Shape > Actions from the menu.  

Web Site Map All menus and controls in the dialogs are accessible via the keyboard. Exceptions within the solution are noted here:

· The Web Site Map solution utilizes two windows, which exhibit the behavior documented under Anchored Windows in General Features above. Although the data is fully accessible, the windows default to the minimized position and cannot be expanded via the keyboard.

· In the Web Site Map Settings dialog checkbox lists, the secondary columns on the Extensions and Protocols property pages may not be exposed to Assistive Technology. 

· ( The “Enable All” and “Disable All” button actions leave the focus on a disabled button. 

Building Plans features consistent keyboard accessibility with the exception of accelerator and shortcut keys. Workarounds are noted here:

· Drag and drop within the Space Planning Explorer window can be accomplished using the following keyboard sequence: Alt+Ctrl+F6, arrow keys, Ctrl+X , Alt+Ctrl+F6, Ctrl+V.

· ( Building Engineering shortcut keys are missing from the right mouse actions for 250 of the 1600 shapes; the controls can be accessed with the Context menu 
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 key and the arrow keys on a standard keyboard.

Process Engineering 

· ( Navigating up and down through combo box lists in the Component Model Properties dialog can cause the focus to jump to another control in the dialog. 

Features specific to diagram utilities

Save As Web Page 

· Not all the available data generated through Save As Web Page can be accessed via the keyboard. 

Find Shape 

· Access to menu items for Find Shape results (Save, Open stencil, View type) requires a right-click action. 

· User cannot toggle via keyboard between the “Any of these words” and “All of these words” radio buttons in the Find Shape window.

· In the Options dialog, keyboard selection of search locations differs from mouse selection. With mouse selection / deselection changes state of child or parent node. Single selection /deselection is possible only with the keyboard. 
· User cannot resize, float, dock or anchor the Find Shape window via keyboard; only the window controls themselves can be manipulated.

XML Property Reporting - XML property reporting in Visio 2002 is keyboard accessible with the following exception:

· The drop-down lists in the Report Wizard Sort dialog are not accessible via the keyboard. However, the drop-down lists can be accessed by tabbing through the controls. 

CAD 

· Under the Layer tab in the CAD Drawing Object Properties dialog, although the down arrow allows layer selection, the individual fields (columns to right, visible, color, line weight) are not selectable via the keyboard. 

Database Wizard
· The Database Wizard does not allow the user to select individual Visio shapes on the drawing page via the keyboard (one of various options for determining which shapes data will be connected to). 

· The Database Wizard arrow keys do not allow movement between the Back, Next, and Cancel options when focus has been set to one of these commands.  

	(b) Applications shall not disrupt or disable activated features of other products that are identified as accessibility features, where those features are developed and documented according to industry standards. Applications also shall not disrupt or disable activated features of any operating system that are identified as accessibility features where the application programming interface for those accessibility features has been documented by the manufacturer of the operating system and is available to the product developer.
	Supported with minor exceptions:

In the vast majority of user scenarios, Visio 2002 does not disrupt or disable accessibility features of the operating system. 

Visio 2002 enables individuals to customize their desktop elements, including resizing and rearranging toolbars and menus, choosing color, size, sound, and format options.

Visio 2002 supports large fonts in the title bar, toolbars and most dialogs. Visio 2002 supports operating system accessibility features including StickyKeys, FilterKeys, MouseKeys, High Contrast, and more.


	General features

· Visio 2002 does not extend operating system user-defined font settings to the document frame due to the need to preserve the WYSIWYG (What You See Is What You Get) User Interface (UI) model; however, Visio 2002 does enable the user to set document font sizes according to their specific needs.

· Visio 2002 does not support large font mode in dialogs where large fonts would render the dialog impossible to read. The operating systems magnifier application is available to magnify dialog text.
· Visio tool tips do not have an adjustable timeout period.

· The drawing window mouse hover time does not follow the appropriate system setting. 

Features specific to diagram types

Gantt Chart

· The New Task and Delete Task button icons on the Gantt Chart toolbar become invisible in High Contrast color schemes.

Save as Web Page

· The HTML output is dependent on the user’s browser to provide compatibility.

Features specific to diagram utilities

Find Shape

· Some of the input controls are not correctly resized in high contrast mode, although the colors and font do change as expected. 

	(c) A well-defined on-screen indication of the current focus shall be provided that moves among interactive interface elements as the input focus changes. The focus shall be programmatically exposed so that Assistive Technology can track focus and focus changes.
	Supported with minor exceptions:

Microsoft Visio 2002 supports technologies that make computer programs more accessible to people who use assistive technology. Visual on-screen focus and tracking is provided throughout Visio 2002. 


	Features specific to diagram types

Organization Chart

· ( In the last screen of the Organization Chart Wizard, the system caret does not match up with the focus indicator. However, the user can tab until the two are matched up.

Project Schedule

· In the Import Project Data Wizard Column Mapping dialog, there are two controls that have two scroll bars each. When the user activates these controls for the first time via tabbing or accelerator key, no visual cue exists to let the user know it has been activated.  
Building Plan

· Although the initial focus for the Space Plan Explorer is correct, arrow key access is not available until the Explorer window is reselected (Ctrl+Shift+F6).

· The Space Plan Label shape dialog does not have any initial focus; although users can bring the cursor to Preview using the Tab key, they cannot type here.

· When the Esc key is used to cancel the Building Engineering Set Display options secondary dialog, the focus is returned to the button that launched the secondary dialog instead of to the top of the dialog. 
 

Features specific to diagram utilities

Color Schemes

· The Color Schemes dialog does not always reflect the correct focus with the Magnifier tool. 

Custom Callout

· The Configure Callout dialog for Custom Callout shapes loses focus when Move Up and Move Down buttons are chosen and subsequently become disabled.  Focus becomes locked into the disabled buttons until the dialog is closed and reopened.  

CAD

· Insert > CAD Drawing (or RMA equivalent on existing CAD display object) > CAD Drawing Properties dialog > Layer results in lack of visual focus indicator on control of layer list box. However, the user can still navigate the list. 

Find Shape

· The cursor does not move correctly between shapes in the results area.  

· The cursor does not move between providers correctly in the options dialog. 

	(d) Sufficient information about a user interface element including the identity, operation and state of the element shall be available to Assistive Technology. When an image represents a program element, the information conveyed by the image must also be available in text.
	Supported with minor exceptions:

Microsoft Visio 2002 User Interface elements include menu bars, toolbars, check boxes and buttons, to name a few.

Visio 2002 supports Microsoft Active Accessibility® programming interface tools as well as the Microsoft Visio Object Model which is available to individuals to access the user interface.
	General features

· The drawing window does not expose shape information to screen reader applications when focus is on a shape. 
· The stencil window does not expose master information to screen reader applications when focus is on a master.

· The ShapeSheet window does not expose section/row/cell information to screen reader applications when the focus is in the ShapeSheet window.

· The Size & Position and Custom Properties windows do not expose grid information to screen reader applications when the focus is in these windows.

· The Help button in Visio dialogs is not exposed to screen readers.  

Features specific to diagram types

· Information in multi-column lists may not be available to Assistive Technology. Several solutions have dialogs with multiple column list boxes that do not fully describe the contents of the lists.

Cross-Functional Flowchart

· In the Cross-functional Flowchart dialog, the name of the graphic corresponding to the Vertical option is incorrectly displayed by Assisted Technology.
Web Site Map

· Not all the information in the Web Site Map Settings dialog is available to Assistive Technology; however, the text can be accessed through the Modify dialog.

Building Plan

· In the Space Plan solution, Color by Value function exhibits split focus between Shape Category and Sample Values. Sample data shows in inspector tool when user focus is on Shape Category.

Features specific to diagram utilities

Save As Web Page

· Individual shapes within diagrams saved as Web pages are keyboard accessible only when the diagram is saved in raster format (gif or jpg), and only if the shape contains a hyperlink.

· Custom properties for non-keyboard accessible shapes are not displayed and are not accessible to Assistive Technology.

· Information about individual shapes in diagrams saved as Web pages is not available to Assistive Technology, with the exception of hyperlink data for keyboard accessible shapes as defined above.

Find Shape

· When the results of a Find Shape query are navigated using the keyboard, invalid information is provided to Assistive Technology. 

	(e) When bitmap images are used to identify controls, status indicators, or other programmatic elements, the meaning assigned to those images shall be consistent throughout an application's performance.
	Supported:
Images used throughout the Visio 2002 application for controls, status indicators, or other programmatic elements are consistent throughout the application and, where applicable, consistent with those found throughout the operating system.
	

	(f) Textual information shall be provided through operating system functions for displaying text. The minimum information that shall be made available is text content, text input caret location, and text attributes.
	Supported with minor exceptions:

Microsoft Visio 2002 uses standard functions to send text to the operating system with one exception noted at right.


	Features specific to diagram types

Gantt Chart

· The buttons on Gantt Chart’s toolbar do not display tool tips when the user navigates to them via the keyboard.  



	(g) Applications shall not override user selected contrast and color selections and other individual display attributes.
	Supported with minor exceptions:

Microsoft Visio 2002 supports system-wide color settings as identified in the operating system display properties.

Visio 2002 does not extend operating system user-defined font settings to the document frame due to the need to preserve the WYSIWYG (What You See is What You Get) User Interface (UI) model, however, Visio 2002 does enable the user to set document font sizes according to their specific needs.

Visio 2002 does not support large font mode in dialogs where large fonts would render the dialog impossible to read.  The operating system magnifier application is available to magnify dialog text.
	General features

· The drawing window does not display shape colors in black/white while in system high-contrast mode.

· The size of the text editor caret does not follow the appropriate system setting.

· The size of shape selection handles in the drawing window does not follow the appropriate system setting.

· The size of the borders of Visio’s anchored windows does not follow the appropriate system setting. 

Features specific to diagram types

Cross-Functional Flowchart

· Under high contrast with extra large fonts, the right menu action for a horizontal functional band ‘Display all band labels horizontally’ is truncated.

· White drawing page under high contrast setting impairs visibility of Functional band (Cross functional flowcharts.vss) and Parallel Mode (basic Flowchart Shapes.vss) shapes.

Gantt chart

· The New Task and Delete Task button icons in the Gantt Chart toolbar become invisible in high contrast color schemes.  

Features specific to diagram utilities

Save As Web

· The diagram (i.e., the Web output) is not altered by the color and contrast settings.

Shapes/Find Shape 

· Find Shape uses system colors for all components except the shape icons, which are provided by the shapes themselves

	(h) When animation is displayed, the information shall be displayable in at least one non-animated presentation mode at the option of the user.
	Supported with minor exceptions:

Visio 2002 includes two animations that contain information not displayed in a non-animated presentation mode; these exceptions are described at right. 


	Features specific to diagram types

Organization Chart

· The Organization Chart animation that occurs when the first shape is dropped on the page provides no documented method for turning off the animation, or for accessing this information through any way other than through the Help system.

Features specific to diagram utilities

Find Shape

· When a Find Shape search is launched, an animated magnifying glass is displayed until search results are returned. 

	(i) Color coding shall not be used as the only means of conveying information, indicating an action, prompting a response, or distinguishing a visual element.


	Supported with minor exceptions:

Visio 2002 uses color coding as an exclusive means to convey information in only three user scenarios, documented at right.
	General features

· (The primary or first selected object in a drawing versus any subsequently selected objects in a multiple selection is indicated through the use of color. However, the user can determine the primary selected object through order of selection.

Features specific to diagram utilities

Find Shape
· The Options link from the Find Shape input window is colored blue to look like a hyperlink.

CAD

· When specifying layer control via color for CAD drawing objects (CAD Drawing Object > Properties > Layer  > Layer control > Color column), color is the only identifier used (no text). 

	(j) When a product permits a user to adjust color and contrast settings, a variety of color selections capable of producing a range of contrast levels shall be provided.


	Supported with minor exceptions: 

All controls provided for color formatting of content or the custom assignment of color to UI elements in Microsoft Visio 2002 allow for a wide range of color and contrast selections. Two high contrast issues are noted at right.


	Features specific to diagram types

Visio stencils

· Any High Contrast issues stated in earlier sections are issues here as well. Many Visio stencils encounter minor High Contrast issues. 

Find Shape
· High contrast mode does not resize some of the input controls correctly, although the colors and font do change as expected. 

	(k) Software shall not use flashing or blinking text, objects, or other elements having a flash or blink frequency greater than 2 Hz and lower than 55 Hz.


	Supported with minor exceptions:

Microsoft Visio 2002 does not contain any flashing or blinking text or objects with one exception noted at right.


	Features specific to diagram types

Space Planning
· Rapid count text when inventorying the data source using the Import Data wizard; rapid shape drop appears as flashing.

	(l) When electronic forms are used, the form shall allow people using Assistive Technology to access the information, field elements, and functionality required for completion and submission of the form, including all directions and cues.
	Supported:

Microsoft Visio 2002 forms provide access through Assistive Technology.
	


Section 1194.22 Web-based Internet information and applications - Detail

Voluntary Product Accessibility Template

Note: Microsoft Visio 2002 documents can be saved as web pages.

	Criteria
	Supporting Features
	Remarks and explanations

	(a) A text equivalent for every non-text element shall be provided (e.g., via "alt", "longdesc", or in element content).
	Not supported:
Microsoft Visio 2002 does not automatically generate a text equivalent to diagrams. 
	Microsoft Visio 2002 diagrams may reflect attributes such as shape, color, size, or position that may not be effectively represented through an automatically generated, exclusively non-visual format. Users can provide text alternatives to diagrams if desired.

	(b) Equivalent alternatives for any multimedia presentation shall be synchronized with the presentation.
	Not applicable


	Microsoft Visio 2002 does not support the inclusion of multimedia in diagrams.

	(c) Web pages shall be designed so that all information conveyed with color is also available without color, for example from context or markup.
	Supported:

Microsoft Visio 2002 includes functionality that allows users to create web pages that conform to these criteria.
	

	(d) Documents shall be organized so they are readable without requiring an associated style sheet.
	Supported:

Microsoft Visio 2002 includes functionality that allows users to create web pages that conform to these criteria.
	

	(e) Redundant text links shall be provided for each active region of a server-side image map.
	Not applicable:
Web output generated by Microsoft Visio 2002 does not include server-side image maps.
	

	(f) Client-side image maps shall be provided instead of server-side image maps except where the regions cannot be defined with an available geometric shape.
	Supported:

Microsoft Visio 2002 includes functionality that allows users to create web pages that conform to these criteria.
	

	(g) Row and column headers shall be identified for data tables.
	Supported:

Microsoft Visio 2002 includes functionality that allows users to create web pages that conform to these criteria.
	

	(h) Markup shall be used to associate data cells and header cells for data tables that have two or more logical levels of row or column headers.
	Not applicable:
Web output generated by Microsoft Visio 2002 does not incorporate data tables with two or more logical levels of row or column headers.
	

	(i) Frames shall be titled with text that facilitates frame identification and navigation
	Supported with exceptions:

Frame titles in Web pages generated with Microsoft Visio 2002, though provided, are not necessarily descriptive of frame contents.
	

	(j) Pages shall be designed to avoid causing the screen to flicker with a frequency greater than 2 Hz and lower than 55 Hz.
	Supported:

Microsoft Visio 2002 includes functionality that allows users to create web pages that conform to these criteria.
	

	(k) A text-only page, with equivalent information or functionality, shall be provided to make a web site comply with the provisions of this part, when compliance cannot be accomplished in any other way. The content of the text-only page shall be updated whenever the primary page changes.
	Supported:

Microsoft Visio 2002 includes functionality that allows users to create web pages that conform to these criteria.
	

	(l) When pages utilize scripting languages to display content, or to create interface elements, the information provided by the script shall be identified with functional text that can be read by Assistive Technology.
	Supported with exceptions:

Microsoft Visio 2002 includes functionality that allows users to create web pages that conform to these criteria.
	Diagrams saved as web pages using Microsoft Visio 2002 are accessible to screen readers using Internet Explorer, with the following caveat:

· ( The arrow navigation items are not keyboard accessible; however, the same functionality can be achieved using keyboard accessible page tabs.

	(m) When a web page requires that an applet, plug-in or other application be present on the client system to interpret page content, the page must provide a link to a plug-in or applet that complies with §1194.21(a) through (l). 
	Not applicable:
Web pages generated with Microsoft Visio 2002 do not require applets or plug-ins.



	

	(n) When electronic forms are designed to be completed on-line, the form shall allow people using Assistive Technology to access the information, field elements, and functionality required for completion and submission of the form, including all directions and cues. 
	Not applicable:

Web pages generated with Microsoft Visio 2002 do not include electronic forms.
	

	(o) A method shall be provided that permits users to skip repetitive navigation links. 
	Supported:

Microsoft Visio 2002 includes functionality that allows web designers to create web pages that conform to these criteria.
	

	(p) When a timed response is required, the user shall be alerted and given sufficient time to indicate more time is required.
	Not applicable:

Microsoft Visio 2002 does not require the user to respond within a specified time for any operation.  
	


Section 1194.31 Functional Performance Criteria - Detail

Voluntary Product Accessibility Template

	Criteria
	Supporting Features
	Remarks and explanations

	(a) At least one mode of operation and information retrieval that does not require user vision shall be provided, or support for assistive technology used by people who are blind or visually impaired shall be provided.
	Not supported: 
Due to the visual nature of diagrams, Microsoft Visio 2002 documents may reflect attributes such as shape, color, size, or position that may not be effectively represented through an automatically generated, exclusively non-visual format. 
	(Commonly used assistive technologies may be used with these products.  Users of assistive technology should contact their assistive technology vendor to assess the compatibility of specific assistive technology with Microsoft products and to learn how to adjust their settings to optimize interoperability.*

	(b) At least one mode of operation and information retrieval that does not require visual acuity greater than 20/70 shall be provided in audio and enlarged print output working together or independently, or support for assistive technology used by people who are visually impaired shall be provided.
	Supported with minor exceptions:

Microsoft Visio 2002 supports the use of screen readers to access user interface information.  

Microsoft Visio 2002, with few exceptions, supports system large font settings.
	(Minor exceptions noted in sections 1194.21 and 1194.22.

Users of Microsoft Windows operating systems can access Magnifier in the Accessibility Options.  An assistive aid may also be used.*

	(c) At least one mode of operation and information retrieval that does not require user hearing shall be provided, or support for assistive technology used by people who are deaf or hard of hearing shall be provided.
	Supported:

Microsoft Visio 2002 does not require user hearing for access to any application functionality.
	

	(d) Where audio information is important for the use of a product, at least one mode of operation and information retrieval shall be provided in an enhanced auditory fashion, or support for assistive hearing devices shall be provided.
	Supported:

Microsoft Visio 2002 does not require user hearing for access to any application functionality. 
	Volume controls are available through the operating system. In addition, an assistive aid may be used.


	(e) At least one mode of operation and information retrieval that does not require user speech shall be provided, or support for assistive technology used by people with disabilities shall be provided.
	Supported:

Visio 2002 does not require speech recognition.


	

	(f) At least one mode of operation and information retrieval that does not require fine motor control or simultaneous actions and that is operable with limited reach and strength shall be provided.
	Supported:

Microsoft Visio 2002 supports operating system tools such as StickyKeys and FilterKeys as well as other assistive technologies.

When the StickyKeys feature is on, the user can press a modifier key (SHIFT, CTRL, or ALT) and then another key in sequence rather than at the same time, to enter shifted (modified) characters and other key combinations. Pressing a modifier key once latches the key down until the user presses a non-modifier key or clicks a mouse button. Pressing a modifier key twice locks the key until the user presses the key a third time.

The FilterKeys accessibility feature allows the user to set the keyboard repeat rate, acceptance delay and bounce rate.
	


Section 1194.41 Information, Documentation, and Support - Detail

Voluntary Product Accessibility Template

	Section 1194.41 (a) Product Support Documentation 


	Supported
	Full product documentation is provided in printed form for customers purchasing retail licenses of Microsoft Visio 2002. Volume license customers can acquire electronic product documentation as part of their volume license. 
The Microsoft Visio Resource Kit is provided in digital format for customers on the Microsoft Visio web site:  http://www.microsoft.com/office/visio. 

	Section 1194.41 (b) Accessibility and Compatibility Features
	Supported
	Microsoft Visio 2002 includes extensive Help File documentation listing accessibility and compatibility features. An individual may access and view Help File topics online or may select a topic for print. 

	1194.41 (c) Support Services


	Supported
	The Microsoft Product Support Services Help Desk is familiar with such features as keyboard access and other options important to people with disabilities.

Microsoft offers a teletypewriter (TTY) service for customers who are hearing impaired. For assistance in the United States, contact Microsoft Technical Support on a TTY at 1-800-892-5234. This service is available Monday through Friday 5:00 A.M. to 9:00 P.M. and 5:00 A.M. to 3:00 P.M. Saturday PST. 

For information on additional support services, visit the Microsoft Accessibility Web site at http://www.microsoft.com/enable/products/support.aspx 



*Note to AT Users: Upon the release of software upgrades, there is often a lag between the software release date and the time it takes for some Assistive Technology manufacturers to upgrade their software and device drivers to support these new releases. The manufacturer’s porting timeframe may be a factor in determining when you decide to upgrade to take advantage of Visio 2002 new features. Microsoft provides the software code within its products to make our products "ready" for the AT devices and works closely with major AT providers in an effort to decrease the time to market for new versions of AT products. We encourage both end users and purchasers of AT to contact their AT manufacturer to determine the current compatibility of their existing AT with Microsoft products.  

This document is for informational purposes only. MICROSOFT MAKES NO WARRANTIES, EXPRESS OR IMPLIED, IN THIS DOCUMENT.

The information contained in this document represents the current view of Microsoft Corporation on the issues discussed as of the date of publication. Because Microsoft must respond to changing market conditions, it should not be interpreted to be a commitment on the part of Microsoft, and Microsoft cannot guarantee the accuracy of any information presented after the date of publication.
Microsoft may have patents, patent applications, trademarks, copyrights, or other intellectual property rights covering subject matter in this document.  Except as expressly provided in any written license agreement from Microsoft, the furnishing of this document does not give you any license to these patents, trademarks, copyrights, or other intellectual property.

© 2002 Microsoft Corporation. All rights reserved. Microsoft, Visio, ShapeSheet, Active Accessibility, and Windows are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries. 
The names of actual companies and products mentioned herein may be the trademarks of their respective owners.

Revised 12/28/2004

Microsoft regularly updates its websites and provides new information about the accessibility of products as that information becomes available.

*Note to AT Users: Upon the release of software upgrades, there is often a lag between the software release date and the time it takes for some Assistive Technology manufacturers to upgrade their software and device drivers to support these new releases. The manufacturer’s porting timeframe may be a factor in determining when you decide to upgrade to take advantage of Microsoft Visio 2002’s new features. Microsoft provides the software code within its products to make our products "ready" for the AT devices and works closely with major AT providers in an effort to decrease the time to market for new versions of AT products. We encourage both end users and purchasers of AT to contact their AT manufacturer to determine the current compatibility of their existing AT with Microsoft products.  





*Note to AT Users: Upon the release of software upgrades, there is often a lag between the software release date and the time it takes for some Assistive Technology manufacturers to upgrade their software and device drivers to support these new releases. The manufacturer’s porting timeframe may be a factor in determining when you decide to upgrade to take advantage of Microsoft Visio 2002’s new features. Microsoft provides the software code within its products to make our products "ready" for the AT devices and works closely with major AT providers in an effort to decrease the time to market for new versions of AT products. We encourage both end users and purchasers of AT to contact their AT manufacturer to determine the current compatibility of their existing AT with Microsoft products.  











( Microsoft usability research indicates that the exceptions noted are not significantly disruptive to product functionality.  In some instances, this symbol indicates that the functionality described is accessible through equivalent, alternative means, via the keyboard utilizing standard menu options.
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